
Standard	business	letter	format	with	cc

http://yftejum.com/c3?utm_term=standard+business+letter+format+with+cc




How	to	Write	Enclosures	at	the...	How	to	Format	for	Block	Letters	How	to	Indicate	Enclosures	in	a...	How	to	End	a	Business	Letter	in...	How	to	Format	a	Business	Letter...	Letter	Etiquette	to	Multiple	Addressees	Personal	Business	Letter	Example	How	to	Cite	an	Attachment	in	a...	How	to	Format	a	Two-Page	Business...	How	to	Address	Two	People	in
a...	How	to	Address	Business	Letters...	How	to	Write	a	Business	Reply	Letter	Business	Letter	Abbreviations	How	to	End	a	Formal	Thank	You	Letter	January	25,	2018	The	NIH	Clinical	Center	is	the	largest	clinical	research	hospital	in	the	country.	Located	in	Bethesda,	Maryland,	the	center	supports...	NIH	Highlights	January	24,	2018	'First	in	Human,'	a
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Channel,	follows	four	patients	at	NIH's	Clinical	Center,...	NIH	Highlights	Photoshop	now	comes	packaged	with	the	Adobe	Creative	Cloud	along	with	other	programs	like	InDesign	and	Adobe	Bridge.	While	the	interface	has	changed	over	the	years,	Photoshop	remains	one	of	the	most	powerful	image	editing	tools	available.	Information	in	this	article
applies	to	the	desktop	version	of	Adobe	Photoshop	CC	2019	for	Windows	and	Mac.	When	you	open	an	image	or	create	a	new	document	in	Photoshop,	you'll	be	taken	to	the	workspace.	The	interface	can	be	customized,	but	the	default	layout	consists	of	four	main	sections:	Main	taskbarTool	optionsToolboxPalettes	If	you	need	help	finding	a	specific	tool
or	panel,	select	the	magnifying	glass	in	the	top-right	corner	to	search	for	it.	You'll	also	have	the	option	to	download	free	graphical	assets	from	Adobe.	To	reset	your	Photoshop	preferences	back	to	the	default	settings,	hold	down	Ctrl	+	Alt	+	Shift	(on	Windows)	or	Command	+	Option	+	Shift	(on	Mac)	immediately	after	launching	Photoshop.	The	main
taskbar	consists	of	nine	menus:	File,	Edit,	Image,	Layer,	Type,	Select,	Filter,	3D,	View,	Window,	and	Help.	If	a	menu	command	is	followed	by	ellipses	(...),	selecting	it	will	open	a	dialog	box.	For	example,	when	you	select	File	>	Place	Embedded,	you'll	be	prompted	to	choose	another	image	that	you	want	to	embed	in	the	current	workspace.	The	tool
options	is	where	you	would	go	to	adjust	settings	for	the	currently	active	tool.	This	toolbar	is	context-sensitive,	which	means	that	it	changes	according	to	which	tool	you	have	selected.	For	example,	when	the	Text	tool	is	active,	you	can	adjust	the	size,	font,	and	alignment	of	the	text.	The	icons	on	the	left	side	of	the	workspace	represent	the	tools	you	have
to	work	with.	Select	the	arrows	at	the	top	of	the	toolbox	(below	the	Home	icon)	to	expand	the	toolbar	so	that	you	can	see	all	of	your	options.	Hold	down	the	mouse	button	as	you	click	each	icon	to	reveal	a	sub-menu	of	additional	tools.	Select	the	ellipses	(...)	at	the	bottom	of	the	toolbar	to	customize	your	preferences,	save	different	presets,	and	even
change	keyboard	shortcuts.	Some	tools	share	the	same	keyboard	shortcut.	For	example,	the	Rectangle	Marquee	and	Elliptical	Marquee	are	both	mapped	to	the	M	key.	To	switch	between	them,	press	Shift	+	M.	Select	the	colored	squares	near	the	bottom	of	the	toolbox	to	set	the	foreground	and	background	colors.	The	foreground	color	is	used	when
you	paint,	fill,	and	stroke	selections.The	background	color	is	used	when	you	make	gradient	fills,	to	fill	in	the	erased	areas	of	an	image,	and	when	you	expand	the	canvas.	Foreground	and	background	colors	are	also	used	by	some	special	effects	filters.	Click	and	hold	the	screen	mode	icon	in	the	bottom-right	of	the	toolbox	to	change	the	appearance	of
the	workspace.	Press	the	F	key	to	toggle	between	all	three	modes.	When	in	either	of	the	full	screen	modes,	you	can	toggle	the	menu	bar	on	and	off	with	the	shortcut	Shift	+	F.	You	can	also	toggle	the	toolbox,	status	bar,	and	palettes	on	and	off	with	the	Tab	key.	To	hide	only	palettes	and	leave	the	toolbox	visible,	use	Shift	+	Tab.	On	the	right	side	of
Photoshop,	you'll	see	the	palette	well	and	several	expanded	palette	panels.	Individual	palette	groups	can	be	moved	around	the	workspace	by	clicking	and	dragging	the	title	bar.	Select	the	menu	icon	in	the	title	bar	area	for	a	list	of	more	options.	Select	Close	Tab	Group	to	hide	the	palette.	If	you	don't	see	palette	you	need,	select	Windows	in	the	main
taskbar	and	choose	your	desired	palette.	You	can	also	ungroup	and	rearrange	the	palettes	by	clicking	on	a	tab	and	dragging	it	outside	of	the	group	or	to	another	group.	Some	palettes	can	be	resized	by	clicking	and	dragging	the	edges.	Several	palettes	can	be	joined	into	one	large	super-palette.	To	do	this,	click	and	drag	a	palette	over	the	title	bar	of
another	palette,	and	then	release	the	mouse	button.	When	multiple	palettes	are	grouped	together,	select	the	title	tab	for	the	palette	you	want	to	bring	to	the	front	of	the	group.	You	can	attach	several	palettes	this	way	to	create	one	massive	palette	collection.	This	can	be	useful	if	you	use	multiple	monitors	and	you	want	to	move	all	your	palettes	to	a
second	monitor.	By	docking	all	the	floating	palettes	together,	you	can	drag	then	all	to	the	second	monitor	with	one	click.	The	palette	well	is	the	vertical	column	of	icons	to	the	left	of	the	floating	palette	panels.	It's	a	place	to	keep	palettes	that	you	don't	want	occupying	your	workspace.	To	move	an	open	panel	to	the	palette	well,	simply	drag	and	drop
the	title	bar	into	the	column.	You	can	then	expand	the	palette	by	selecting	its	icon	from	the	well.	Select	the	arrows	in	the	top-right	corner	of	the	palette	panels	section	to	collapse	the	panels	into	a	side	bar	menu.	Select	Window	>	Workspace	>	New	Workspace	to	save	your	workspace	settings.	When	you	go	to	the	Window	>	Workspace	in	the	future,
you'll	see	your	new	saved	workspace	at	the	top	of	the	menu.	To	return	the	palettes	to	their	default	locations,	go	to	Window	>	Workspace	>	Reset.	If	you	open	another	document	while	in	the	Photoshop	workspace,	a	new	tab	will	open	under	the	tool	options	bar.	You	can	quickly	switch	between	documents	by	clicking	these	tabs.	Under	the	image	is	the
status	bar,	which	displays	various	information	about	the	current	document.	Select	the	arrow	in	the	status	bar	to	choose	which	information	to	display.	Adjust	the	zoom	by	selecting	View	from	the	menu	taskbar,	or	use	the	Zoom	tool.	If	you	want	the	document	window	to	resize	as	you	zoom	in	and	out,	select	Resize	Windows	to	Fit	box	in	the	tool	options
bar.	Select	Fit	to	Screen	to	make	the	entire	image	fit	within	the	workspace.	To	zoom	in	and	out	without	switching	to	the	zoom	tool,	hold	Ctrl	(on	Windows)	or	Command	(on	Mac)	and	press	the	plus	(+)	and	minus	(-)	keys.	Thanks	for	letting	us	know!	Tell	us	why!	What	comes	to	mind	when	you	hear	the	phrase	business	letters?	Do	white	envelopes	with
fancy	letterheads	and	stuffy	writing	come	to	mind?	In	most	cases,	you’d	be	right.	Make	your	letter	look	professional	by	using	a	stylish	letterhead	template	like	this	one	Even	if	almost	everything	is	done	via	email	nowadays,	business	letters	aren’t	extinct	or	considered	totally	out	of	style	so	it	still	pays	to	know	how	to	write	and	format	them	properly.		
Parts	of	a	Standard	Business	Letter	Format	As	you’ve	probably	learned	in	primary	school,	business	letters	are	composed	of	different	parts.	This	section	covers	what’s	included	in	each	part	and	the	correct	business	letter	format.	1.	Sender’s	Information	It’s	important	to	know	how	to	address	a	business	letter	properly,	especially	if	you’re	expecting	a
reply.	This	section	includes	your	complete	address,	phone	number,	and	email	address.	Some	people	like	to	include	their	complete	name	at	the	top	of	this	list,	but	some	people	think	it’s	redundant	because	you’ll	be	signing	the	letter	with	your	name	anyway.	You	don’t	need	to	include	this	if	the	paper	you’re	using	has	a	letterhead.	What	to	include	and
formatting:	Name	Street	Address	City,	State,	Zip	Code	Country	(if	not	in	the	same	country	as	your	recipient)	Your	Phone	Number	Your	Email	2.	Today’s	Date	Spell	out	the	month	and	include	the	complete	year.	Write	the	month,	date,	and	year	if	sending	a	business	letter	in	the	U.S.,	but	start	the	date	with	the	day	(e.g.	18	October	2018)	if	you’re
sending	a	letter	in	the	U.K.	or	Australia.	3.	Addressee	Information	(a.k.a.	Inside	Address)	Include	the	recipient’s	information,	starting	with	their	name,	followed	by	their	job	title	and	complete	address.	Address	the	recipient	using	Ms.,	Mr.,	or	use	any	job-appropriate	title	as	necessary	Name	Job	Title	Company	Street	Address	City,	State,	Zip	Code
Country	(optional)	4.	Salutation	The	salutation	used	in	the	addressee	section	doesn’t	have	to	be	the	same	as	the	one	used	here.	It	all	depends	on	how	close	or	familiar	you	are	with	the	address,	and	the	context	of	your	letter.	The	Dean	at	the	College	of	Sciences	may	be	your	aunt,	but	if	you’re	writing	to	her	in	an	official	capacity,	it’s	best	if	you	use	the
salutation	“Dean	(Last	Name)”	or	“Dr.	(Last	Name)”	because	there’s	a	chance	that	other	people	handle	her	correspondence.	Military	and	religious	titles	should	be	written	as	is.	Not	sure	of	the	recipient’s	gender?	Don’t	use	Mr.	or	Ms.,	just	write	“Dear”	followed	by	their	full	name.	If	you	don’t	know	who	the	exact	contact	person	is,	“To	Whom	it	May
Concern”	will	do.	You	can	also	address	the	department	or	group	that'll	handle	your	letter,	such	as	“Members	of	the	Hiring	Committee”	or	“Condominium	Association	Management.”	Always	end	the	salutation	with	a	colon,	not	a	comma.	5.	Body	Text	The	body	of	the	letter	is	usually	composed	of	one	to	three	brief	paragraphs,	each	with	a	specific	intent
and	organized	for	clarity.		Introduction.	Explains	the	reason	for	the	letter	and	what	you	want	to	achieve	with	it.	If	the	recipient	doesn’t	know	who	you	are,	you	can	also	mention	mutual	connections	here.	Second	paragraph.	Gives	more	detail	about	your	request,	such	as	the	steps	you’ve	taken	or	fees	paid.	In	case	of	marketing	or	job	application	letters,
the	second	paragraph	is	where	you’ll	sell	the	product	you’re	promoting	or	your	application.	Third	paragraph.	Optional	and	is	included	in	situations	where	the	second	paragraph	isn’t	enough	to	explain	the	situation	in	full.		Closing	The	closing	includes	one	or	two	sentences	that	request	the	recipient	to	take	whatever	action	is	requested	in	your	letter,
and	thanks	them	for	reading	your	mail.	Examples	of	business	letter	closing:	Please	email	me	at	(your	email)	or	call	me	at	(your	business	phone)	to	schedule	a	meeting.	Thank	you	for	your	consideration.	If	you	need	to	discuss	anything	with	me	or	the	team,	please	don’t	hesitate	to	call	us	at	(your	phone).	We're	always	at	your	service.	Complimentary
Close																The	complimentary	close	is	a	sign-off	phrase	inserted	before	your	signature.	You've	got	lots	of	options	here,	but	in	general	you	should	avoid	those	that	denote	appreciation	or	thanks	in	letters	where	you’re	not	requesting	anything.	Examples	Regards	Sincerely	Cordially	With	gratitude	Kind	Regards	With	appreciation	Yours	truly	The
Signature	Sign	the	letter	below	the	complimentary	close.	Make	sure	to	leave	at	least	four	single	spaces	between	your	name	and	closing	so	there’s	enough	room	for	your	signature.	You	may	want	to	include	your	job	title,	phone	number,	and	email	address	below	your	full	name	too.	Enclosures	Before	the	age	of	email,	people	wrote	“Enclosures”	at	the
bottom	of	business	letters	to	indicate	that	the	envelope	includes	other	documents.	Think	of	it	as	the	print	version	of	“see	attachment”	for	emails.	Enclosures	are	noted	at	the	bottom	left	of	the	letter,	a	couple	of	spaces	below	your	signature,	followed	by	a	list	of	the	documents	included.	For	example:	Enclosures:	3	Types	of	Business	Letter	Formats
Business	letters	usually	come	in	one	of	three	main	formats,	full	block,	modified,	or	indented.		While	there’s	no	right	or	wrong	format,	there	are	instances	like	in	university	applications,	where	a	specific	format	is	required.	If	you’re	not	sure	which	format	to	follow,	just	check	previous	letters	you’ve	received	from	the	institution	and	follow	the	same
formatting.	1.	Full	Block	Full	block	is	the	most	common	format	for	business	letters	because	it’s	the	easiest	one.	You	don’t	have	to	worry	about	indents	and	everything	is	left	justified.	Single	spacing	is	used	instead	of	indents	for	new	paragraphs.	Below	is	an	example	of	a	full	block	letter	from	the	University	of	North	Carolina	Writing	Center:	2.	Modified
The	modified	format	is	a	bit	hard	to	remember	because	not	everything	is	left-justified.	The	addressee,	salutation,	and	the	body	of	the	letter	are	left	justified,	while	the	sender’s	address,	date,	complimentary	close,	and	signature	are	aligned	to	the	right.	In	the	example	below,	there	are	two	spaces	between	the	sender’s	address	and	the	date	when	the
letter	was	written	and	three	spaces	between	the	recipient’s	address	and	salutation.	There	are	also	two	spaces	between	the	first	paragraph	of	the	letter	body	and	salutation	and	two	spaces	for	every	new	paragraph.	The	complimentary	close,	signature,	and	the	last	paragraph	of	the	letter	are	all	two	spaces	apart.	Below	is	an	example	of	a	business	letter
in	modified	format	from	Savvy	Business	Correspondence:	3.	Indented	The	indented	or	semi-block	format	is	similar	to	the	modified	format,	except	that	the	start	of	every	paragraph	is	indented.		Business	Letter	Formatting	and	Design	Tips	Your	business	letter	needs	to	make	a	good	first	impression,	because	in	some	cases	reading	that	letter	will	be	the
first	time	the	recipient	“encounters”	your	company.	1.	Professional	Letterhead	Companies	aren’t	the	only	ones	who	can	use	letterheads.	Solopreneurs,	job	applicants,	and	anyone	who	wishes	to	make	a	brand	for	himself	can	use	a	letterhead	to	make	their	letters	unique.	Letterheads	can	also	be	used	to	verify	the	document’s	authenticity	to	the	recipient,
which	is	often	the	case	for	government	letters	and	bank	letters.	You	can	find	professional	letterhead	stationery	templates	on	Envato	Elements	or	GraphicRiver.	Letterhead	design	varies,	the	only	thing	that’s	consistent	is	that	it	must	include	your	company’s	name	and	logo,	address,	and	contact	information.	If	you	don’t	have	a	logo	or	company	name,
just	replace	this	with	part	with	your	full	name.		Since	business	letters	are	formal,	choose	a	letterhead	design	that’s	not	too	busy	or	colorful	that	it	detracts	from	the	message	you’re	sending.	Don’t	use	stationery	or	scented	paper.	Want	to	create	your	own	letterhead?	Check	out	these	templates	from	Envato:	10	Business	Letterhead	Design	Tips	(With
Killer	Brand	Identity	Examples)	2.	Business	Letter	Margins	It’s	good	to	save	trees,	but	don’t	squeeze	too	much	text	into	one	page	that	there’s	no	margin	left.	Leave	1”	to	1.5”	per	side.	3.	Plain	Font	Avoid	fancy	fonts	and	hard	to	read	cursive.	Stick	to	Verdana,	Arial,	Courier	New,	or	Times	New	Roman	with	a	minimum	font	size	of	12.	4.	Formal	Letter
Spacing	Use	single	space	between	paragraphs	to	make	the	letter	easier	to	read.	You	should	also	use	at	least	one	single	space	between	all	elements	of	the	letter,	except	between	your	signature	and	printed	name	where	four	line	breaks	are	required.	5.	Second-page	Letterhead	for	Additional	Pages	Business	letters	should	be	concise	enough	to	only	need
one	page,	but	that’s	not	always	the	case.	Legal	contracts,	complaints,	and	some	advisory	letters	sometimes	require	additional	pages.	To	avoid	confusion	in	case	the	letter	pages	get	separated,	the	second	and	subsequent	pages	should	include	a	letterhead	and	a	page	number	at	the	top.	You	may	also	want	to	include	the	date	and	recipient’s	name.	Types
of	Business	Letters	Business	letters	are	sent	for	all	sorts	of	reasons.	Businesses	send	it	to	their	customers	or	to	other	businesses	they	work	with,	such	as	vendors	or	logistics	partners.	Individuals	write	business	letters	for	business	and	less	formal	purposes	too.	Here	are	some	examples	of	types	of	business	letters:	1.	Letter	of	Complaint	Not	all
complaints	can	be	aired	and	addressed	properly	on	social	media,	some	topics	are	a	little	sensitive	or	embarrassing	you	don’t	want	to	run	the	risk	of	it	going	viral.	Then	there	are	complaints	where	a	call	to	the	company’s	customer	service	hotline	isn’t	enough.	For	all	these	complaints,	a	printed	letter	of	complaint	is	the	answer.	Make	your	complaint
brief,	to	the	point,	and	polite.	Don’t	just	make	it	about	what	the	company	did	wrong	tell	them	exactly	what	you	want	them	to	do	about	it.	2.	Resignation	Letter	A	resignation	letter	is	what	an	employee	sends	to	their	boss	when	they	want	to	quit	their	job.	In	most	cases,	you’ll	need	to	allow	at	least	14	days	or	two	weeks	before	your	official	departure	date
from	the	company.	Below	is	an	example	of	a	resignation	letter	from	American	Recruiters:	Note:	If	you	don't	know	the	gender	of	the	person	who'll	receive	your	letter	it's	better	to	use	a	generic	greeting	like	"to	whom	it	may	concern"	than	to	use	"Mr./Ms."	or	"Sir."	3.	Cover	Letter	A	printed	cover	letter	is	sent	along	with	a	resume	to	briefly	explain	why
you’re	a	good	candidate	for	the	job.	Good	cover	letters	are	like	appetizers	in	a	sense	that	it	gives	recruiters	a	sense	of	what	they	can	expect	from	you,	without	necessarily	repeating	what’s	already	on	your	resume.	Read	these	guides	for	more	information	about	writing	a	cover	letter:	How	to	Write	a	Cover	Letter:	The	Ultimate	Guide	20	Cover	Letter
Examples	for	Your	2022	Job	Search	22	Email	Cover	Letter	Tips:	With	Easy	to	Follow	Samples	4.	Recommendation	Letter	Recommendation	letters	are	sent	to	verify	an	applicant’s	good	standing	with	a	previous	employer	or	manager.	In	some	cases,	these	recommendations	are	nothing	more	than	a	template	generated	by	someone	from	HR	after	filling	in
the	blanks	about	an	employee’s	start	and	end	date.	If	you’re	writing	a	cover	letter	for	a	good	employee,	however,	it’s	better	if	you	go	beyond	the	template	to	show	that	you	appreciate	the	time	you	worked	together.	Check	out	this	guide	if	you	need	any	help	with	writing	a	recommendation	letter:	How	to	Write	an	Excellent	Letter	of	Recommendation
(+Templates)	5.	Letter	to	Request	information	Letters	requesting	for	information	are	often	sent	to	businesses	by	individuals	or	representatives	of	other	businesses	when	they	want	information	on	a	particular	product	or	service.	These	letters	can	also	be	written	to	government	offices	when	requesting	information	about	applying	for	a	permit	or	inquiring
about	a	government	procedure.	Below	is	an	example	of	a	letter	to	request	information	from	Word	Mart:	Note:	If	you	don't	know	the	gender	of	the	person	who'll	receive	your	letter	it's	better	to	use	a	generic	greeting	like	"to	whom	it	may	concern"	than	to	use	"Mr./Ms."	or	"Sir.":	6.	Adjustment	or	Change	Letter	Have	you	ever	received	a	letter	stating
your	phone	bill’s	due	date	was	adjusted,	or	that	the	amount	you’re	paying	has	been	changed?	That’s	an	adjustment	letter.	It’s	not	all	about	dates	and	amounts	though,	adjustment	or	change	letters	are	also	sent	when	businesses	want	to	notify	customers	about	changes	in	the	product	or	service	they	bought.	Below	is	an	example	of	a	due	date	adjustment
letter	from	Corporate	Finance	Institute:		7.	Business	Announcements	and	Invitations	Stockholder	letters,	new	product	announcements,	and	charity	events	are	business	letters.	Letters	announcing	a	new	CEO,	an	IPO,	and	even	those	inviting	you	to	a	convention	also	fall	under	business	announcement	letters.	These	letters	are	either	sent	as	an	internal
memo	so	all	employees	are	aware	of	changes	within	the	company,	or	as	an	announcement	to	company	stakeholders.	Here’s	an	example	of	a	business	invitation	for	an	educational	seminar	from	Letters.org:	Note:	If	you	don't	know	the	gender	of	the	person	who'll	receive	your	letter	it's	better	to	use	a	generic	greeting	like	"to	whom	it	may	concern"	than
to	use	"Mr./Ms."	or	"Sir."			Tips	on	Writing	Business	Letters	Using	the	right	justification	and	including	all	the	right	elements	isn’t	enough	for	a	good	business	letter.	Even	more	important	is	to	strike	the	right	tone	and	ensure	that	your	recipient	understands	your	letter’s	intent.	Keep	the	following	tips	in	mind	next	time	you	write	a	business	letter.	1.
Short	and	Simple	Avoid	highfalutin	words	and	flowery	descriptions.	Keep	the	first	paragraph	brief.	If	you’re	not	sure	how	to	start,	just	write	“I’m	writing	in	reference	to…”	then	explain	your	request	from	there.	2.	Reader's	Benefit	It’s	easier	to	get	the	recipient’s	cooperation	if	you	write	a	letter	with	their	benefit	in	mind.	Emphasize	what	you	can	do
offer	them	instead	of	what	you	want	them	to	do.	3.	Right	Tone	What's	the	purpose	of	the	letter	you’re	sending?	Are	you	expressing	thanks,	sympathy,	or	demanding	payment	for	debt?	Whatever	it	is,	you've	got	to	establish	the	right	tone	so	the	recipient	understands	the	urgency	of	your	request.	4.	No	Jargon	Avoid	jargon	unless	you’re	absolutely	sure
the	recipient	will	understand	what	you’re	talking	about.	5.	Use	of	Personal	Pronouns	Even	if	this	is	a	business	letter,	it’s	okay	to	use	personal	pronouns	like	you,	I,	we,	and	us.	Stick	with	“I”	if	you’re	writing	based	on	your	opinion,	and	use	“We”	if	you’re	writing	on	behalf	of	the	company.	6.	Add	CC	When	Needed	Did	you	know	that	“CC”	means	courtesy
copy?	Back	in	the	day	when	letters	where	typewritten,	“CC”	meant	carbon	copy	because	that’s	what	typists	use	when	making	duplicates.	Either	way,	this	is	the	abbreviation	you	should	include	below	the	enclosure	line	if	you	plan	to	send	a	copy	of	the	letter	to	someone	else.	If	you’re	sending	a	courtesy	copy	to	more	than	one	person,	list	the	second
name	underneath	the	first	without	the	“CC.”	Example:	“Cc:	Mark	Smith,	Chief	Financial	Officer	XYZ	Widgets”	The	Format	for	Email	Business	Letters	According	to	texting	experts,	Text	Request,	only	20%	of	emails	are	opened	and	95%	of	texts	are	read	within	three	minutes	of	receipt,	while	a	huge	amount	of	mail	gets	lost	or	trashed	immediately,	it’s	no
wonder	some	businesses	go	as	far	as	sending	correspondence	via	print	and	email	followed	by	a	shortened	version	as	a	text,	just	to	ensure	the	recipient	gets	it.	To	maintain	an	air	of	formality	while	adapting	to	the	digital	medium,	the	formatting	and	all	elements	of	the	printed	business	letter	are	still	included	in	an	email	business	letter,	except	for	two
small	differences.	The	subject	line	serves	as	a	letter	summary	or	an	indication	of	what	the	letter	is	about.	The	sender’s	information	is	located	at	the	bottom	of	the	letter,	just	below	the	printed	name	of	the	sender.		To	learn	more	about	how	to	format	email	messages	study	the	following	tutorials:	How	to	Master	Proper	Business	Email	Format	-	and	Avoid
Professional	Disaster	How	to	Properly	Write	a	Formal	Email	(That	Gets	Results)	How	to	Write	a	More	Effective	Email	(15+	Best	Tips	&	Tricks)	Send	Wisely	Use	a	business	envelope	if	you’re	sending	a	letter	via	post.	Use	an	envelope	with	your	company’s	logo	so	the	recipient	can	immediately	recognize	it’s	from	your	company	and	to	prevent	your	letter
from	getting	trashed	along	with	other	promotional	junk	they	receive.		If	you’re	not	sure	whether	your	handwriting	is	legible,	use	your	printer	and	word	processor	to	print	the	address	on	the	envelope.	Send	important	documents	and	time-sensitive	letters	via	courier.		Now	that	you've	learned	how	to	format	a	letter,	you	can	start	sending	out	your	own
business	letters.	Editorial	Note:	This	content	was	originally	published	in	2018.	We're	sharing	it	again	because	our	editors	have	determined	that	this	information	is	still	accurate	and	relevant.
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